TCCC
Web-Based Training Standards Guide
Draft
June 2009
# Table of Contents

Introduction .............................................................................................................. 4  
Background .............................................................................................................. 4  
Document Content ................................................................................................... 4  
Process Overview ..................................................................................................... 4  
Development Team .................................................................................................. 5  
Taxonomy .................................................................................................................. 5  
Deliverables .............................................................................................................. 5  
Process ...................................................................................................................... 7  
Analysis Phase ......................................................................................................... 7  
  High-level Design Plan (HDP) .............................................................................. 7  
  HDP Approval Criteria ......................................................................................... 8  
Design Phase ............................................................................................................ 8  
  Detailed-level Design Plan (DDP) ...................................................................... 9  
  DDP Approval Criteria ......................................................................................... 9  
  Prototype .............................................................................................................. 9  
  Prototype Approval Criteria ............................................................................... 10  
Development Phase .................................................................................................. 10  
  Draft PowerPoint Slide Presentation ................................................................ 10  
  Storyboard Approval Criteria .......................................................................... 11  
Implementation Phase .............................................................................................. 12  
  Pilot-Ready Materials ....................................................................................... 12  
  Post-Pilot Updates ............................................................................................ 13  
Evaluation Phase ..................................................................................................... 13  
  Course Evaluation ............................................................................................. 14  
  Process Evaluation ............................................................................................ 14  
Instructional Design Standards ................................................................................ 15  
  General Standards ............................................................................................. 15  
Screen Layout .......................................................................................................... 15  
  Screen Design .................................................................................................. 15  
Text Layout .............................................................................................................. 15  
  Text Use ........................................................................................................... 16  
Interactivity .............................................................................................................. 16  
  Embedded Practice ............................................................................................. 17  
  Learner Feedback and Remediation for Embedded Practice .......................... 17  
  Bookmarking .................................................................................................... 17  
  Course Completion Requirements .................................................................... 17  
Quality Control (QC) and Quality Assurance (QA) ............................................... 18  
Development Tools ................................................................................................. 18  
Graphical User Interface ......................................................................................... 18  
  Curriculum ........................................................................................................ 18  
  Navigation ......................................................................................................... 19  
Media Standards ..................................................................................................... 20  
  Graphics ............................................................................................................ 20  
  Animation ......................................................................................................... 20
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Use</td>
<td>20</td>
</tr>
<tr>
<td>Video Use</td>
<td>21</td>
</tr>
<tr>
<td>Platform Standards</td>
<td>21</td>
</tr>
<tr>
<td>Hardware</td>
<td>21</td>
</tr>
<tr>
<td>Browser Specification</td>
<td>21</td>
</tr>
<tr>
<td>Hosting Specificaitons</td>
<td>21</td>
</tr>
<tr>
<td>Writing Standards</td>
<td>21</td>
</tr>
<tr>
<td>General Writing Guidelines</td>
<td>21</td>
</tr>
<tr>
<td>Acronyms and Abbreviations</td>
<td>22</td>
</tr>
<tr>
<td>Punctuation</td>
<td>22</td>
</tr>
<tr>
<td>Bullets Use</td>
<td>22</td>
</tr>
<tr>
<td>Numbers</td>
<td>23</td>
</tr>
<tr>
<td>Date and Time</td>
<td>23</td>
</tr>
<tr>
<td>Capitalization</td>
<td>23</td>
</tr>
<tr>
<td>Emphasis</td>
<td>23</td>
</tr>
<tr>
<td>508 Considerations</td>
<td>23</td>
</tr>
<tr>
<td>508 Compliance Standards</td>
<td>24</td>
</tr>
<tr>
<td>LMS Integration</td>
<td>29</td>
</tr>
<tr>
<td>Adobe Presenter</td>
<td>30</td>
</tr>
<tr>
<td>Templates</td>
<td>30</td>
</tr>
<tr>
<td>Standardized Screen Types</td>
<td>30</td>
</tr>
<tr>
<td>Adobe Presenter Settings</td>
<td>33</td>
</tr>
<tr>
<td>Theme Editor Settings</td>
<td>33</td>
</tr>
<tr>
<td>Knowledge Check Settings</td>
<td>34</td>
</tr>
<tr>
<td>Learner Assessment Settings</td>
<td>37</td>
</tr>
<tr>
<td>Question Formatting on PowerPoint slides</td>
<td>39</td>
</tr>
<tr>
<td>Presentation Settings</td>
<td>40</td>
</tr>
<tr>
<td>Slide Manager</td>
<td>40</td>
</tr>
<tr>
<td>Hyperlinks</td>
<td>40</td>
</tr>
<tr>
<td>Embedding Flash Objects (Published Captivate Animation)</td>
<td>41</td>
</tr>
<tr>
<td>Level 1 Evaluation</td>
<td>44</td>
</tr>
<tr>
<td>Create an Evaluation Link</td>
<td>44</td>
</tr>
<tr>
<td>Add Link to Course</td>
<td>44</td>
</tr>
<tr>
<td>Add Ancillary Files</td>
<td>45</td>
</tr>
<tr>
<td>Acronym List</td>
<td>47</td>
</tr>
</tbody>
</table>
Introduction

Background

The National Highway Institute/Transportation Curriculum Coordination Council (TCCC) Web-based Training Standards Guide provides the standards to be followed when developing Web-based Training (WBT) for the Transportation Curriculum Coordination Council in partnership with the National Highway Institute (NHI).

Document Content

This Guide focuses on:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>Provides basic background information regarding this document and its intended use, and introduces the basic terms and concepts used in TCCC courseware development.</td>
</tr>
<tr>
<td>Process</td>
<td>Provides an explanation of the activities and deliverables within each phase of the ADDIE process.</td>
</tr>
<tr>
<td>Instructional Design Standards</td>
<td>Provides guidance on the instructional quality that TCCC expects for the courseware and defines instructional standards.</td>
</tr>
<tr>
<td>Adobe Presenter</td>
<td>Provides guidance on the functional and development standards that grant a consistent look and feel to TCCC courseware.</td>
</tr>
<tr>
<td>Appendix</td>
<td>Provides additional information and document templates referenced in this document.</td>
</tr>
</tbody>
</table>

Process Overview

WBT courseware will be developed using the Instructional Systems Design (ISD) process, sometimes known as the ADDIE process. Phases of this process include:

1. Analysis
2. Design
3. Development
4. Implementation
5. Evaluation

The flow chart below illustrates the TCCC WBT content development process.
Development Team

It is TCCC’s expectation that a fully-qualified instructional systems designer (ISD) will be responsible for the development of analysis and design phase deliverables. In the appropriate phases of the project, TCCC expects the ISD to work with a multi-disciplinary team that includes:

- Subject Matter Expert(s)
- TCCC ISDs
- Content Reviewer(s) (also Subject Matter Experts) to include a designated “Lead Reviewer”
- Graphic Artist(s)
- Quality Assurance Specialist(s)
- Web Developer(s)/Programmer(s) *
- Audio/Video Producer(s) **

* Adobe Presenter does not require the use of a Web programmer/developer. However, experience with other Adobe products like Flash, Captivate, Acrobat, etc. is helpful.

** An audio/video producer may be needed when professional audio narration or video is planned.

Taxonomy

TCCC WBT courseware is developed using the following taxonomy:

<table>
<thead>
<tr>
<th>Course</th>
<th>Module 1</th>
<th>Module 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Lesson 1</td>
<td>Lesson 1</td>
</tr>
<tr>
<td></td>
<td>Lesson 2</td>
<td>Lesson 2</td>
</tr>
<tr>
<td></td>
<td>Lesson 3</td>
<td>Lesson 3</td>
</tr>
<tr>
<td></td>
<td>Lesson 4</td>
<td>Lesson 4</td>
</tr>
</tbody>
</table>

All courses will include modules; lessons are optional. For purposes of the Sharable Content Object Reusability Model (SCORM), a sharable content object (SCO) is defined at the module level.

Course learning outcomes are equivalent to course learning objectives.

Deliverables

The following may be specified as deliverables in contracts for custom e-Learning courseware development:

<table>
<thead>
<tr>
<th>Phase</th>
<th>Deliverable(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning</td>
<td>Work Plan (tasks, resources, start/end dates, dependencies)</td>
</tr>
<tr>
<td>Analysis</td>
<td>High-level Design Plan (HDP) (approach, scope, outcomes)</td>
</tr>
<tr>
<td>Design</td>
<td>• Detailed-level Design Plan (DDP) (instructional strategies, media)</td>
</tr>
<tr>
<td></td>
<td>• Prototype Storyboards and Published Prototype (1 Lesson or designated Module portion)</td>
</tr>
<tr>
<td>Development</td>
<td>• Published storyboards consisting of detailed PowerPoint Slides including audio scripts and media elements</td>
</tr>
<tr>
<td></td>
<td>• Published Beta PowerPoint files for each module, end-of-course</td>
</tr>
</tbody>
</table>
### TCCC WBT Training Standards Guide

<table>
<thead>
<tr>
<th>Section</th>
<th>Deliverables</th>
</tr>
</thead>
</table>
| Implementation| • Final PowerPoint and audio files  
• Final Media Source files (i.e., Flash, Captivate, video, etc.)  
• Final Resource files |
| Evaluation*   | Test Items as submitted in Beta and Final PowerPoint files                  |

*NHI will provide a URL for the standard NHI Level 1 course evaluation form for insertion in the Assessment Report Screen

Samples of each of these deliverables will be provided upon request.

TCCC shall hold ownership of the final courseware, including the PowerPoint files and all final and raw audio, video, Flash (.FLA) and graphic files. The final deliverable files shall be provided to TCCC on CD-ROM following the recommended folder and file naming conventions.
Process

Analysis Phase

Sound instructional design practice requires designers/developers to analyze the business driver(s), target audience needs, content, budget, schedule, and delivery options as part of the Analysis Phase of a WBT development project.

Figure 2.1 - 1 depicts the analysis phase within the ADDIE Process.

Figure 2.1 - 2 depicts primary tasks and deliverables within the Analysis phase, with review and revision occurring throughout the phase.

High-level Design Plan (HDP)

The HDP contains the findings and recommendations as a result of the analysis phase. This high-level document ensures the course is instructionally sound (defined as job relevant, task based, problem centered, interactive, engaging and well organized).

The HDP template contains the following sections:
- Introduction and Background
- Statement of Business Need
- Target Audience Characteristics
- Course Goal(s)
- Course Learning Outcomes (Terminal Learning Objectives, required; Enabling Objectives, optional)
- Overarching Instructional Approach (e.g., theme, metaphor)
- Delivery Method(s)
- Course Structure (diagrams of modules that show chunking and sequence of instruction)
- Use of media (animation, audio, video), if recommended
- Level of Interactivity
- Estimated Course Duration, by module
- Evaluation Strategy (high-level)
Designers/Developers must use the TCCC-provided HDP template. The MS Word 2000 template contains boilerplate text and provides all the sections that must be completed. Specific instructions are included in the template. Depending on the conversion effort, an HDP may or may not be required. In some instances, only a Detailed-level Design Plan may be needed.

**HDP Approval Criteria**

A draft version of the HDP will be submitted to TCCC. The TCCC team and others as designated will review and provide comments. Developer/Designers are required to address the comments, providing details on what was changed and/or the reason(s) why the comment was not incorporated. Iterative versions of the document are considered draft, until all issues are resolved to TCCC’s satisfaction – then the document can be submitted as final.

**Design Phase**

Once the initial analysis is complete and approved, the design of the content can begin. The detailed-level design plan expands on the areas outlined in the high-level plan to build the basic course structure. The information in this report establishes the baseline for the project design and development.

Figure 2.2 – 1 depicts the Design phase within the ADDIE Process.

**Figure 2.2 - 2**

![Diagram](image)

Figure 2.2 - 2 depicts primary tasks and deliverables within the Design phase, with review and revision occurring throughout the phase.

**Figure 2.2 - 2**

![Diagram](image)
Detailed-level Design Plan (DDP)

The detailed plan provides the details on how the content will map to the objectives and how the content will be presented, practiced and tested. Using the content outline and the content identified in the HDP, projected timelines for tasks and milestones are also developed. These tasks and milestones are based on procedures for design, testing, implementation, and evaluation for online course development.

The DDP template contains the following sections:
- Introduction and Background
- Course Level Details
- Module Level Details
- Lesson Level Details (if lessons are used)
- Content and exercises mapped to each course learning outcome (in bulleted or outline format)
- Graphics designated to enhance content
- Estimated Duration, by course, module and lesson (if applicable)
- Proposed use of narration, if applicable
- Specific use of additional audio and/or video, if recommended
- Level 2 evaluation and remediation strategy, including number and type of test items and feedback/remediation standards
- Identification of prototype content

DDP Approval Criteria

A draft version of the DDP will be submitted to TCCC. The TCCC team and others as designated will review and provide comments. Developer/Designers are required to address the comments, providing details on what was changed, and/or the reason(s) why the comment as not incorporated. Iterative versions of the document are considered draft, until all issues are resolved to TCCC’s satisfaction – then the document can be submitted as final.

Preliminary work on PowerPoint storyboards for the prototype may begin prior to the final approval of the DDP. However, the initial draft DDP must precede any work on the storyboards.

Prototype

The prototype provides a functional sample of the content designed and developed in accordance with the WBT standards and instructional strategies identified in the DDP. Changes required to the WBT standards and instructional strategies are identified and approved by TCCC early in the design phase. Global changes at the prototype phase are considerably less time- and cost-intensive than later in the design or development process.

Developers/Designers will designate a specific lesson as the prototype, which should approximately be twenty screens. Rationale for this selection as the prototype may include the following:
- Content for this section is among the most stable or best-documented in the material.
- All functionality to be included in the project is included in this subsection.
- This content is the foundation for other content in the project, and its development will facilitate the development of other content.

The prototype must be delivered to TCCC as a published file. The purpose of the prototype is to illustrate:
- Creativity
- Level of interactivity
- Opportunities for practice
- Writing style
- Understanding of adult learning principles
Adherence to standards
Accuracy of content
Treatment of content

Depending on the conversion effort, a prototype may or may not be required. In some instances, storyboard development of modules may directly follow the deliverables required in the Analysis phase.

Prototype Approval Criteria

The draft version of the Prototype will be reviewed by the TCCC team and others as designated. This may be done as a group review via Web conference or individually. If reviewed individually, reviewers will provide written comments on a supplied comment form. If reviewed via a Web conference, the Developer/Design team is responsible for capturing all comments. All comments must be addressed, providing details on what was changed, and/or the reason(s) why the comments are not incorporated. Iterative versions of the prototype are considered draft, until all issues are resolved to TCCC’s satisfaction - then the prototype can be submitted as a published file.

Development Phase

TCCC defines a storyboard set as a set of PowerPoint slides with attached audio file for a single module, due to the relatively short length of the modules. Delivery, review and revision cycles will occur on a module-by-module basis.

Figure 2.3 - 1 depicts the Development phase within the ADDIE Process.

Draft PowerPoint Slide Presentation

The designer/developer will create draft PowerPoint storyboard slides for each module that include:
- On-screen text
- Visuals (e.g., royalty-free photos, diagrams, descriptions of planned Flash animations)
• Narration script in the Notes section
• Script for new video, if any
• End-of-course test answer key, if end-of-course test is used

Each draft module should be delivered as a published. The designer/developer will submit for review and comment:
• Published draft PowerPoint files
• Any ancillary, support, or resource files
• Rough cut (scratch) audio - if provided

The designer/developer will submit an end-of-course assessment as a separate .ppt file, if appropriate, and all relevant supporting files. The designer/developer will also submit a traceability document that supports the end-of-course assessment as a Level 2 evaluation, if appropriate. The traceability document will allow TCCC to quickly and easily determine validity of the Level 2 instrument, as well as facilitate later updates of content. It will identify, by objective, the:
  o Assessment item that effectively tests learner mastery of an objective
  o Location in the courseware of supporting content

Use the following file naming conventions, as described in the Archiving Recommendations, for draft deliverables:

<table>
<thead>
<tr>
<th>File Type Abbreviation</th>
<th>File Type</th>
<th>Naming Convention</th>
</tr>
</thead>
<tbody>
<tr>
<td>PP</td>
<td>PowerPoint Presentation</td>
<td>Course Number_Type_Date_Desc.Ext</td>
</tr>
<tr>
<td>EX</td>
<td>Exam</td>
<td>Auto-generated audio file by Adobe Presenter</td>
</tr>
<tr>
<td>OM</td>
<td>Other Materials</td>
<td>EX: 123456_OM_20090120_Module1OverviewofErosionControl.VideoScript_Draft.doc</td>
</tr>
<tr>
<td>Draft Deliverable</td>
<td>Naming Convention</td>
<td>EX: 123456_OM_20090120_Module1OverviewofErosionControl_Draft.wav</td>
</tr>
<tr>
<td>Ancillary Files</td>
<td>Course Number_Type_Date_Desc. Ext</td>
<td>EX: 123456_OM_20090120_Module1OverviewofErosionControl_Draft.wav</td>
</tr>
<tr>
<td>Audio .wav file</td>
<td>Course Number_Type_Date_Desc. Ext</td>
<td>EX: 123456_EX_20090120_DraftTestA.ppt</td>
</tr>
<tr>
<td>End-of-course</td>
<td>Course Number_Type_Date_Desc. Ext</td>
<td>EX: 123456_EX_20090120_DraftAnswerKey.ppt</td>
</tr>
<tr>
<td>assessment .ppt file</td>
<td></td>
<td></td>
</tr>
<tr>
<td>End-of-course</td>
<td>Course Number_Type_Date_Desc. Ext</td>
<td>EX: 123456_EX_20090120_DraftAnswerKey.ppt</td>
</tr>
<tr>
<td>answer key .doc file</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

NOTE: The module title should be consistently abbreviated in the file name.

Storyboard Approval Criteria

The draft version of the Storyboards will be reviewed by the TCCC team and others as designated. The reviewers will provide written comments on a supplied comment form. Developer/Designers are required to address the comments, providing details on what was changed, and/or the reason(s) why the comment as not incorporated. Iterative versions of the storyboards are considered draft, until all issues are resolved to TCCC’s satisfaction - then the storyboards can be published and will be used to create the pilot-ready version of all course materials.
Implementation Phase

TCCC will coordinate and conduct an online pilot of the WBT with representative members of the target audience. A minimum of six participants is required.

Figure 2.4 - 1 depicts the Implementation phase within the ADDIE Process.

Figure 2.4 - 1

![ADDIE Process Diagram](AddieDiagram.png)

Review and Revise

Figure 2.4 - 2 depicts primary tasks and deliverables within the Implementation phase, with review and revision occurring throughout the phase. The course, including the end-of-course assessment, is used for the pilot test. Upon completion of the implementation phase, the course is ready for wide-spread deployment.

Figure 2.4 - 2

![Implementation Tasks Diagram](ImplementationDiagram.png)

Review and Revise

Pilot-Ready Materials

The following final products are required for pilot:

- Published PowerPoint files for each module
- Published PowerPoint files for end-of-course assessment (if applicable)
- Script (included in the Notes section within PowerPoint)
- Embedded link to the Level 1 online course evaluation

Use the following file naming conventions for pilot deliverables:

<table>
<thead>
<tr>
<th>Pilot Deliverable</th>
<th>Naming Convention</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each module .ppt file</td>
<td>Course Number_Type_Date_Desc.Ext&lt;br&gt;EX: 123456_PP_20090120_Module1OverviewofErosionControl_Draft.ppt</td>
</tr>
<tr>
<td>End-of-course assessment .ppt file</td>
<td>Course Number_Type_Date_Desc.&lt;br&gt;EX: 123456_EX_20090120_DraftTestA.ppt</td>
</tr>
<tr>
<td>Ancillary Files</td>
<td>Course Number_Type_Date_Desc.&lt;br&gt;EX:123456_OM_20090120Module1OverviewofErosionControl_VideoScript_Draft.doc</td>
</tr>
</tbody>
</table>
The designer/developer should plan to participate in the pilot by reviewing all Level 1 and Level 2 data collected by TCCC. The ISD will submit feedback to the designer/developer using the Participant Evaluation Form template within two days of the conclusion of the pilot. The ISD and designer/developer will review the feedback and decide which feedback to implement and which to set aside.

Post-Pilot Updates

The designer/developer will create a set of final course materials that reflect the documented and agreed upon changes resulting from the pilot.

Use the following file naming conventions the final deliverables:

<table>
<thead>
<tr>
<th>Final Deliverable</th>
<th>Naming Convention</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each module .ppt file</td>
<td>Course Number_Type_Date_Desc.Ext</td>
</tr>
<tr>
<td></td>
<td>EX: 123456_PP_20090120_module1_Final.ppt</td>
</tr>
<tr>
<td>Each end-of-course assessment .ppt file</td>
<td>Course Number_Type_Date_Desc.Ext</td>
</tr>
<tr>
<td></td>
<td>EX: 123456_EX_20090120_EXFinal.ppt</td>
</tr>
<tr>
<td>All supporting files (.swf)</td>
<td>Course Number_Type_Date_Desc.Ext</td>
</tr>
<tr>
<td></td>
<td>EX: 123456_OM_20090120_module1.swf</td>
</tr>
<tr>
<td>All original supporting files</td>
<td>Course Number_Type_Date_Desc.Ext</td>
</tr>
<tr>
<td></td>
<td>EX: 123456_OM_20090120_Module1.wav</td>
</tr>
</tbody>
</table>

Evaluation Phase

TCCC evaluates both the courseware that was developed as well as the development process itself. Upon completion of the courseware evaluation, the designer/development team discusses Lessons Learned over the life of the project.

Figure 2.5 - 1 depicts the Evaluation phase within the ADDIE Process.

Figure 2.5 - 1 depicts primary tasks and deliverables within the Evaluation phase. TCCC evaluates the course for efficacy; TCCC and the design/development team document lessons learned. Upon completion of the Evaluation phase, the project is considered complete.
Course Evaluation

TCCC uses Kirkpatrick’s Levels of Evaluation model to determine efficacy of training. TCCC selected Kirkpatrick’s model due to its versatility for evaluating multiple modes of training consistently, and its standing as an industry best practice.

TCCC will manage the collection and analysis of Level 1 and Level 2 data. TCCC uses a standardized, online Level 1 assessment. The designer/developer will develop the Level 2 evaluation during the Development phase, with the rest of the course. TCCC may use the traceability document to assist in courseware evaluation.

<table>
<thead>
<tr>
<th>Level</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| Level 1 | • The learner accesses the TCCC standard WBT course evaluation provided by NHI via a URL.  
• Learners are directed to the Level 1 Course Evaluation link on the report screen of the end-of-course assessment. |
| Level 2 | • Not required by policy  
• TCCC welcomes discussion of performance evaluation at level 2. |
| Level 3 | • Not required by policy.  
• TCCC welcomes discussion of performance evaluation at level 3. |
| Level 4 | • Not required by policy.  
• TCCC welcomes discussion of performance evaluation at level 4. |

Process Evaluation

The designer/developer will coordinate and facilitate a one-hour Lessons Learned meeting within two weeks of completion of delivery of the final product. The meeting may be held virtually. If applicable, the designer/developer will document lessons learned and submit a brief Lessons Learned document in MS Word covering things done well and areas for improvement for:

- Development Process - general comments
- Communication (internal and external)
- Technical issues
- Management
Instructional Design Standards

General Standards

Use the following general standards:

- Design modules that are approximately 30 to 90 minutes in duration. The duration is measured by the amount of time it takes an average learner to read through all the presented material, access provided options, and listen to all included audio.
- Maintain module and lesson consistency by:
  - Developing module and lesson welcome screens that illustrate the relevance of the content to the learner
  - Including estimated module and lesson completion times in a consistent location and manner
  - Ending each lesson with a summary that recaps the content and ties it to the learning outcomes
  - Using tone and voice within the writing and audio
- State learning outcomes clearly and succinctly at the course and module levels
- Allow learner to navigate and determine order of modules or lessons
- Begin each module and lesson with something compelling that will create a desire to learn
- Create the shortest module and lesson titles needed to convey meaning
- Ensure coherent flow between screens by including transitions
- Address one concept, procedure or item of instruction on each page
- Include a resource feature, when applicable, for:
  - Sited documents
  - A bibliography
  - Relevant Web resources
  - Similar items
- Include a glossary
- Provide verbatim audio script text in the Notes section, if audio is used
- Modify the standard Help file if course unique instructions are required
- Provide learners with information in the fewest steps and shortest time possible
- Use royalty-free graphics and photographs to add visual interest
- Use custom illustrations and interactions to teach complex concepts
- Model diversity by avoiding stereotypes of race, gender or ethnicity
- Develop course-level assessments that test every terminal learning objective if applicable
- Employ adult learning principles to keep learners motivated
- Employ instructional strategies that take into consideration different learning styles

Screen Layout

All screen layout standards are already incorporated into the templates. Media standards are used to maintain style consistency within the following areas.

Screen Design

- Establish a specific location for the presentation of instructions and prompts
- Provide recurring information in consistent locations
- Use white space to separate blocks of text

Text Layout

- Present information in a top down, left to right instructional format
- Layout content so a screen reader will read the text and alt tags in the correct order.
- Design text layout in short segments or phrases
- Break up blocks of text to make it easier for the learner to scan the content
- Use bullets, numbered lists, tables and charts to break up lengthy sentences
Text Use

- Use consistent color for text and graphics throughout a course
- Font size and color:
  - **Course Title** - Verdana 16-point bold - RGB color: 255, 255, 255
  - **Module Title** - Verdana 12-point Italicized - RGB color: 255, 255, 255
  - **Screen Title** - Verdana 24-point - RGB color: 0, 0, 0
  - **Instruction text** - Bullet Level 1 - Verdana 22-point - RGB color: 0, 0, 0
  - **Instruction text** - Bullet Level 2 - Verdana 20-point - RGB color 0, 0, 0
  - **Instruction text** - Bullet Level 3 - Verdana 18-point - RGB color 0, 0, 0
  - **Hyperlink text** - Verdana - RGB color 150, 150, 150

*Use of other font type, size or color must be approved by TCCC*

- Underline hyperlinks only;
- Use bold font sparingly to emphasize a word or phrase
- Do not use all capital letters or underlining to emphasize words or phrases
- Do not use blinking text or repetitive animation

Interactivity

Interactivity should be used throughout the courses to engage the learner and allow him or her to practice applying the information whenever possible. Use of interactivity is strongly encouraged. The level of interactivity is documented in the High-Level Design Plan. TCCC uses the following definitions to describe the degree of interactivity:

<table>
<thead>
<tr>
<th>Level of Interactivity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level I - Passive</td>
<td>The learner acts solely as a receiver of information. The learner progresses linearly through course reading text from the screen, viewing video or listening to audio. Results in approximately 80 screens per hour of screen time.</td>
</tr>
<tr>
<td>Level II - Limited Interaction</td>
<td>The learner makes simple responses to instructional cues. The responses may include answering multiple choice or true/false questions. Results in approximately 60 screens per hour of screen time. Example: Embedded “Knowledge Checks”</td>
</tr>
<tr>
<td>Level III - Complex Participation</td>
<td>The learner makes a variety of responses using varied techniques in response to instructional cues. Results in approximately 45 screens per hour of screen time. Example: Building a model/diagram from available parts.</td>
</tr>
</tbody>
</table>

The degree of interactivity in any e-Learning product is based upon relative importance of the content, budget, timeline, shelf life, and audience size. Learners should interact with the courseware consistent with the defined level of interactivity designated for the course. It may be appropriate to design modules within the same course for different levels of interactivity (e.g., foundational principles along with complex, branched case studies for application of those principles; the foundational module might be developed at Level I, whereas the application module might be developed at Level III).

- Use interactive instructional strategies (e.g., an “Explore It” interaction where the learner selects several text labels, graphical elements, or photographs for further information)
- Include a wide variety of interaction types to keep the learner engaged throughout the course
- Adhere to the standard set of learner prompts for each screen and interaction type
• The most common interaction prompts the learner to select an object to learn more about a topic. Prompts for this type of interaction should be constructed as follows. Select the [object] to learn more about [topic].

Embedded Practice

Use Knowledge Checks as embedded practices. Embedded practice provides opportunities for reinforcement after each concept or skill is presented. Practice exercises are evaluated, but the scores are not sent to the learning management system. Other points to consider include:

• Provide the context for the practice activity by relating it to a concept or job skill in introductory text
• Ensure practice opportunities are directly linked to learning outcomes (i.e., terminal and/or enabling learning objectives)
• Use the standard TCCC Knowledge Check screen for embedded practice exercises
• List up to five (5) possible answer choices for multiple choice questions
  • Format answer choices as:
    a) Answer option
    b) Answer option
    c) Answer option
• Use radio buttons when there is one correct answer and the standard prompt: “Select the correct answer. Then select the Submit button.”
• Use check boxes when there are multiple correct answers and use the standard prompt: “Select all answers that apply. Then select the Submit button.”
• Provide a Knowledge Checks debrief slide for 508 compliance

Learner Feedback and Remediation for Embedded Practice

Each Knowledge Check should allow for two tries except for true/false, which allow only one try for a correct answer. When the learner submits and answer, advise whether the answer is correct or incorrect and include the standard prompt “Select anywhere to continue.” Provide the learner with feedback on the Knowledge Check Debrief slide to help enable learning. Feedback always starts with either “Correct” or Incorrect”, followed by the corrective or reinforcing feedback.

Bookmarking

Adobe Presenter automatically bookmarks the location a learner is at every 10 pages and/ or every time an embedded practice is completed. Should a learner exit a course without completing the module, Adobe Presenter “bookmarks” the page the learner was on. This allows a learner to return to the same location and complete the course.

Course Completion Requirements

Adobe Presenter requires every lesson and/or module end with a scored item. A learner must “submit” at the end in order for the lesson/module to record as complete in LMS tracking. This is accomplished by using one of the following:

• Use a Knowledge Check to provide the summary page for the lesson/module, including one unscored question at the end such as: “Do you understand all of the content covered in this section?” The “No” response would provide feedback telling the learner to go back over the lesson/module for review. The “Yes” response would congratulate the learner and inform them they have successfully completed the lesson/module.
• Provide a scored test at the end of the lesson/module

After successfully completing a course, learners will be able to download a course certificate (there is no requirement to take the end-of-course assessment in order to download a certificate. TCCC will
provide a URL to the developer to include in the last course screen. The URL is a link to the downloadable Adobe Acrobat course certificate file.

WBT Development Standards

**Quality Control (QC) and Quality Assurance (QA)**

TCCC requires development teams to complete QC and QA reviews on all deliverables (draft and final) prior to submission to TCCC. Testing is required on the prototype and final versions. QC, QA, and testing artifacts should be provided to TCCC upon request.

In general, the development team should ensure:

- Teaching and testing strategies comply with the standards provided in the TCCC WBT Style Guide
- Text complies with the standards provided in the TCCC WBT Style Guide
- Media complies with the standards provided in the TCCC WBT Style Guide
- Alpha tests are conducted on all supported operating systems and browsers
- LMS integration testing is completed
- Thorough quality assurance testing is conducted on published versions of Alpha, Beta, and Final courseware

The TCCC review is neither a QC nor QA review. The role of TCCC is to review for content accuracy. Development teams must ensure compliance with the TCCC WBT guide, SCORM, and Section 508.

**Development Tools**

All WBT developed for TCCC must use Adobe Presenter 7, a PowerPoint to Flash conversion tool. Developers will need to purchase a developer’s license for Adobe Presenter 7 and the Presenter plug-in. Before starting the development phase, the contractor must obtain the latest version of the TCCC WBT Template to use in conjunction with this style guide.

Other tools for use should be non-proprietary, and include:

- Adobe Flash (version 7.0 or later)
- JavaScript
- Adobe Photoshop
- Adobe Premiere
- Adobe Captivate
- Adobe Acrobat

Other development tools require TCCC approval.

**Graphical User Interface**

The graphical user interface (GUI) is standard and included in the templates. Any course unique additions or changes to the GUI are requested, a rationale must be provided in writing to the TCCC point of contact for the course, and must be approved.

**Curriculum**

The course curriculum is provided on the FHWA Adobe Training server. Modules are listed in numerical order.

**Module level:**

- Create the shortest module titles needed to convey meaning
Use descriptive headings, e.g.: Module 1 Overview of Erosion Control

- Titles limited to 45 characters, including spaces
- The module curriculum is provided within in .ppt file. Lesson Titles appears in the left-hand frame of the WBT template as a set of links to lesson introductory screens within a module
  - Create the shortest lesson titles needed to convey meaning
  - Use Descriptive headings, e.g., Lesson 2: Planning Erosion Control Measures
  - Titles limited to 45 characters, including spaces

Navigation

The use of consistent navigation standards will add to learner satisfaction and retention. The following standards apply to all web-based courseware:

- Intuitive, learner controlled navigational
- Provide clear instructions or cues for all required learner activities. Use boilerplate text where provided
- Navigational elements will provide one click access to learners and should include the following:
  - **Resources**: Direct learners to course-level ancillary items (additional reading, source documents, policy documents)
  - **Help**: Direct learners to navigational guidance. TCCC provide standard Help content available at https://admin.na3.acrobat.com/_a55098539/wbthelp.
  - **Glossary**: Direct learners to a course-level list of terms and definitions. The glossary may be delivered as a Flash paper document or as a self-contained Presenter module.

**NOTE**: Other navigational buttons may be added, as appropriate. However, the location of navigational buttons is specified in the standard TCCC GUI. The buttons (e.g., Submit, Play, and Replay) should be consistent within each course.

- Mouse cursor changes and rollover highlights must be consistent within a course
- Learners must be able to control all navigation to accommodate all users. Buttons will have text description labels (alt tags) as part of the template
- Navigation buttons must display in the same position on every page
- Modules and lessons can be completed in any order, unless the instructional design requires sequential accomplishment (if this is required, provide instructions to the learners)
- Use breadcrumbs to help learners quickly identify their location in a course
- Course titles are limited to 60 characters, including spaces
- Module titles are limited to 45 characters, including spaces
- Lesson titles are limited to 45 characters, including spaces
- Screen titles are limited to 45 characters, including spaces
- Use the following screen title standards (these will show in the sidebar and used for navigation):
  - Module X Objectives 1, 2, 3, etc.
  - Module X Review
  - Lesson X Objectives
  - Lesson X Review
  - Module X Quiz Introduction
  - Module X Quiz Results
  - Course Assessment Introduction
  - Course Assessment Results
Media Standards

Media standards provide a consistent look and feel to courses, as well as offering assurance that the media will function as intended on the training platform.

Graphics

- Use the TCCC-provided color palette (provided at project onset) as part of the TCCC WBT templates
- Use colors that accommodate learners who are color blind
- Establish and maintain a convention for the use of color(s) to denote meaning, however, so not use color as an instructional cue
- Maintain a constant perspective in a series of visuals
- Do not include contractor or other corporate logos in the courseware
- Avoid graphics that may become outdated in a short time
- If using clipart, verify it is royalty free or obtain written permission for use
- Do not use cartoon characters
- All text within the graphic must be readable. If the graphic needs to be scaled down, then there should be a “select to enlarge” feature
- Be consistent with all graphics (with the use of borders, effects and quality)
- Do not use drop shadows
- Make sure there is no advertising in the photo (e.g., car model name, billboard signs, license plates)
- Deliver raw files to TCCC as compressed, processed files and .PSD with layers preserved
- A text version of all graphic elements will be provided (e.g. image description for a graphic) in both the notes section and in the Alternate Text field for that graphic

Animation

- Allow user to control the animation to include: start, stop, and replay
- Do not use blinking graphics or text
- Use special effects when required for emphasis or transition
- Do not use any special effects that detract from learning or as the main element of learning.
- Use animation to display concepts that are difficult to describe with narration and/or text
- Raw files built in flash delivered to TCCC as .fla.
- A text version of all animated elements will be provided as appropriate

Audio Use

- Use audio judiciously (e.g., to demonstrate interpersonal skills, to demonstrate sounds heard on the job, to engage the learner - such as providing a talking coach)
- Include verbatim text of any audio in the Notes section of each Power Point slide
- Ensure audio volume levels are consistent throughout the course
- Use one audio talent to narrate all modules within the same course. If role-playing, multiple voice talent may be used, but roles must be consistent.
- Use sound effects only when they help to convey the content - but they cannot be used to provide the only means for learning
- TCCC standards for audio edits
  - Place 1.5 seconds of silence at the beginning of every slide
  - Place 1.5 seconds of silence at the end of every slide
- If audio is recorded outside of the Adobe Presenter tool:
  - Raw audio files delivered to TCCC as .WAV or MP3
  - Recommended audio editing tool is Adobe Premiere, but others are acceptable as long as the final product is .wav
Video Use

- Use video to reinforce, clarify or emphasize a specific behavior or performance objective that cannot be effectively taught using graphics, stills, photographs or animation
- Videos must be captioned to comply with accessibility requirements
- Avoid continuous video clips because of file size
- Use appropriate video (e.g., talking head, show and tell, interview, panel discussion, simulation or dramatization)
- Avoid techniques such as zooming, panning, transitional wipes, dissolves and fast motion subjects due to buffering problems which tend to hinder streaming media performance
- Raw files delivered to TCCC as compressed digital files - .FLV or .AVI

Platform Standards

All courseware should be designed for use on the minimum platform configurations to reach the widest possible audience. Since TCCC does not have control over all courseware consumers training platforms, the following standards were developed internally and represent the baseline for online courseware.

Hardware

Design courseware to perform on the standard hardware configuration in use at the time of development. Minimum configuration includes the following:

- Minimum operating system: Windows 2000
- Minimum processor speed: 328 MHz
- Standard screen resolution: 800 x 600
- Color depth: 16 bit

Browser Specification

Design courseware for optimal viewing using the standard FHWA configuration browser.

- Internet Explorer 6.0
- Flash Player 7.0 or higher

Hosting Specificaitons

All TCCC WBT courseware resides on the FHWA Server (http://fhwa.na3.acrobat.com).

Writing Standards

Adherence to an established writing style provides continuity and consistency within a course and across the curriculum.

General Writing Guidelines

- Use active voice, second person (you), present tense, and conversational tone when appropriate
- Keep language simple, concise and consistent
- Do not use hyphens to break words
- Avoid jargon and slang
- Use examples that are universally understood
- Avoid references that learners with English as a second language would have difficulty understanding
- Avoid the use of contractions (unless the course is consistently conversational in style)
Avoid language and examples that will reduce the shelf life of the courseware, such as dates and references to current events.

Do not use all capital letters. Learners have more difficulty reading text that is all capitalized than mixed-case letters (and learners perceive all-cap type as being yelled at).

Italic should only be used for titles of published works and words that are appropriated from other languages and have not become standard English (e.g., détente).

Use “select” in learner prompts (“click” or “click on” are not compliant with Section 508).

Acronyms and Abbreviations

Write out the full name of the entity, followed by its acronym in parentheses for first time use on a page.

Acronyms do not include spaces or periods.

Abbreviations should be used when using titles before and after names (e.g., Mr., Mrs., PhD).

Use abbreviations when the acronym for a corporation, institution or country is more familiar than the full name (e.g., USA, IBM, FBI, FedEx).

Use abbreviations for mathematical measurements (e.g., lb., kg.).

Include acronyms in the glossary.

Punctuation

Use one space after periods and colons.

Do not use serial commas immediately preceding “and” or “or” (a serial comma is the last comma in a series of items).

Use a hyphen to connect words in a sequence (e.g., 2003-2004, pp. 28-72).

Do not use hyphens to separate syllables within a word.

Do not use hyphens to connect two related parts of a sentence.

Place all punctuation inside the quotation marks.

Establish and adhere to a standard symbol for first and second level bullets.

Do not use an Em Dash.

Use an En Dash to connect related parts of a sentence (e.g., TCCC expects the vendor to ensure - through thorough quality testing - compliance to this Guide, SCORM, AICC, and Section 508).

Use a space before and after an En Dash (as shown in example above).

Do not use a “/” - it is read as “slash” by screen readers.

Bullets Use

Maintain parallel construction in a bullet list (e.g., start all bulleted items with a verb).

Use no more than two levels in a bulleted or numbered list.

Use numbered bullets where sequence is important (e.g., the five sequential steps of the ADDIE model); use symbols for bullets when order is not important.

Use a colon at the end of the introductory sentence (i.e., stem of before bullet list).

Capitalize the first word in each bulleted phrase or sentence.

Do not place a period at the end of learning outcomes, even when stated in a complete sentences.

Begin phrases (bulleted items that are not complete sentences) with caps and end without punctuation.

Do not use “and” or “or” in bulleted sequences on screen.

Do not use a comma after each bulleted item.

Do not put a period at the end of the last bullet in a list of bulleted items.

Do not use a bullet (number or symbol) when there is only one item; there must be at least two items to make a bullet list.
Numbers

- Use figures to express the numbers 10 and above, as well as all numbers representing mathematical functions or quantities, dates, ages, time, money and numbers as part of a series.
- Spell out the numbers nine and below unless they represent precise measurement (e.g., 8.2578) or are part of a complex mathematical formula.
- Spell out any number that begins a sentence, title or heading.

Date and Time

- Write out the date in full (e.g., July 4, 1776).
- Use a colon to separate hours and minutes (e.g., 9:00 a.m.).
- Include Time Zone (EST, CST, MST, PST), if applicable.

Capitalization

- In headlines, capitalize all words except definite/indefinite articles, prepositions and conjunctions that are shorter than four letters.
- When using bullets, capitalize the first word contained in each bullet.
- Capitalize the word “State” whenever referring to one of the 50 States.
- Capitalize the word “Federal” as in Federal Government.
- Do not capitalize the word “federally”.

Emphasis

- Avoid excessive use of bolding (it can be distracting and should be reserved for headings).
- Do not use italics for emphasis (they are hard to read on screen and are used specifically for citations).
- Do not underline (underlined text can be confused with a hyperlink).
- Do not use quotation marks for emphasis.
- Use headings and subheadings to draw attention to specific concepts.

508 Considerations

This section provides information relevant to Section 508. All TCCC technology-based training products must be in compliance with these standards.

The following statement summarizes Section 508, Part 1194.21 regarding software applications and operating systems:

Most of the specifications for software pertain to usability for people with vision impairments. For example, on provision requires alternative keyboard navigation, which is essential for people with vision impairments who cannot rely on pointing devices, such as a mouse. Other provisions address animated displays, color, and contrast settings, flash rate, and electronic forms, among others.

TCCC follows standards published by the Access Board (http://www.access-board.gov/sec508/guide/index.htm). All courseware developed must be in adherence with the Access Board standards. When requested, the development team must document proof of accessibility.
There is no designated TCCC-standard assistive technology. Courseware should be developed for functionality using assistive technology agreed to be the project development team.

508 Compliance Standards

Courses must be accessible to persons with disabilities in accordance with section 508 of the Rehabilitation Act Amendments of 1998. Proposals should address how the course would meet the requirements of this Act.

The Contractor will coordinate with the Contracting Officers Technical Representative (COTR) for overall technical direction. The COTR will convene designated U.S. Department of Transportation (USDOT) staff to serve as technical experts, and assist in the review and approval of course materials. Technical experts will represent USDOT, as appropriate.

The Final Rule, Electronic and Information Technology Accessibility Standards, published in the Federal Register on December 21, 2000, provides guidance on how a Contractor can meet these requirements (see, 36 CFR Part 1194 [Docket no. 2000-01] RIN 3014-AA25). There are also a number of readily available resources on the Rehabilitation Act including several web sites. See, for example, www.section508.gov and www.access-board.gov. Additionally, a number of organizations provide technical information on making websites accessible for the disabled. Such organizations include but are certainly not limited to:

- The Web Consortium (www.w3.org)
- The HTML Writers Guild (www.hwg.org)
- The Rochester Institute of Technology’s Equal Access to Software and Information website (http://people.rit.edu/easi/)
- The University of Wisconsin-Madison’s Trace Research and Development Center (www.trace.wisc.edu)

See also:


The requirements for Web-based applications as described in § 1194.22 the December 21, 2000 Final Rule, e.g.:

(a) A text equivalent for every non-text element shall be provided (e.g., via “alt”, “longdesc”, or in element content).
(b) Equivalent alternatives for any multimedia presentation shall be synchronized with the presentation.
(c) Web pages shall be designed so that all information conveyed with color is also available without color, for example from context or markup.
(d) Documents shall be organized so they are readable without requiring an associated style sheet.
(e) Redundant text links shall be provided for each active region of a server-side image map.
(f) Client-side image maps shall be provided instead of server-side image maps except where the regions cannot be defined with an available geometric shape.
(g) Row and column headers shall be identified for data tables.
(h) Markup shall be used to associate data cells and header cells for data tables that have two or more logical levels of row or column headers.
(i) Frames shall be titled with text that facilitates frame identification and navigation.
(j) Pages shall be designed to avoid causing the screen to flicker with a frequency greater than 2 Hz and lower than 55 Hz.
(k) A text-only page, with equivalent information or functionality, shall be provided to make a Web site comply with the provisions of this part, when compliance cannot be accomplished in
any other way. The content of the text-only page shall be updated whenever the primary page changes.

(l) When pages utilize scripting languages to display content, or to create interface elements, the information provided by the script shall be identified with functional text that can be read by assistive technology.

(m) When a Web page requires that an applet, plug-in or other application be present on the client system to interpret page content, the page must provide a link to a plug-in or applet that complies with § 1194.21 (a) through (f).

(n) Whenever electronic forms are to be completed online, the forms shall allow people using assistive technology to access the information, field elements, and functionality required for completion and submission of the form, including all directions and cues.

(o) A method shall be provided that permits users to skip repetitive navigation links.

(p) When a timed response is required, the user shall be alerted and given sufficient time to indicate more time is required.

Note to § 1194.22: 1. The Board interprets paragraphs (a) through (k) of this section as consistent with the following priority 1 Checkpoints of the Web Content Accessibility Guidelines 1.0 (WCAG 1.0) (May 5, 1999) published by the Web Accessibility Initiative of the World Wide Web Consortium:

<table>
<thead>
<tr>
<th>Section 1194.22 Paragraph</th>
<th>WCAG 1.0 Checkpoint</th>
</tr>
</thead>
<tbody>
<tr>
<td>(a)</td>
<td>1.1</td>
</tr>
<tr>
<td>(b)</td>
<td>1.4</td>
</tr>
<tr>
<td>(c)</td>
<td>2.1</td>
</tr>
<tr>
<td>(d)</td>
<td>6.1</td>
</tr>
<tr>
<td>(e)</td>
<td>1.2</td>
</tr>
<tr>
<td>(f)</td>
<td>9.1</td>
</tr>
<tr>
<td>(g)</td>
<td>5.1</td>
</tr>
<tr>
<td>(h)</td>
<td>5.2</td>
</tr>
<tr>
<td>(i)</td>
<td>12.1</td>
</tr>
<tr>
<td>(j)</td>
<td>7.1</td>
</tr>
<tr>
<td>(k)</td>
<td>11.4</td>
</tr>
</tbody>
</table>

2. Paragraphs (l), (m), (n), (o), and (p) of this section are different from WCAG 1.0. Web pages that conform to WCAG 1.0, level A (i.e., all priority 1 checkpoints) must also meet paragraphs (l), (m), (n), (o), and (p) of this section to comply with this section. WCAG 1.0 is available at: [http://www.w3.org/TR/1999/WAI-WEBCONTENT-19990505](http://www.w3.org/TR/1999/WAI-WEBCONTENT-19990505)

TCCC WBT Section 508 Compliance and Adobe Presenter Tips

TCCC recognizes the importance compliance with Section 508, not only as a legal requirement, but to provide the most robust, comprehensive, and highest quality training possible. In an effort to remain consistent in our standards and compliant with Section 508 requirements, this section was created to record all of the Section 508 styles, requirements, and lessons learned that we have discovered. Because TCCC uses Adobe Presenter to develop Web-based Training, the information in this section refers exclusively to that development tool.

Slides and Slide Content

All content on the slide must, in some capacity, be reflected in the notes (narration) section of the training.

1. Graphics - Any graphic on the slide must be provided in a written description in the narration as well as in the Alternative Text field for the graphic. This is referred to as an “Image description” and the correct format for documenting this is as follows.

   Image description: <brief, succinct, accurate description of the image>
2. **Tables** - Data that is presented in a table must be either included in the general narration or provided as a table description. A table description is formatted like an image description. The information or data must make sense presented in a narrative format. Redundant or repeated information should be presented logically and not simply repeated.

3. **Onscreen content in shapes or presented in a way other than a text box** - Some content on the screen may be presented in a PowerPoint shape to make the screen visually interesting. For example, the screen shot below has information about Course Approach in Information Boxes.

![Course Approach](image)

This information should be presented either in the narration or as a separate description, not read by the narrator, labeled as appropriate.

4. **Links/Hyperlinks** - Links to other pages within the document or to external web pages or documents should be documented in the narration in some capacity. If there is a link to another place in the same document (one slide links to another slide) this link should either be described in the narration (i.e. “For more information, please navigate to slide 38.”) or the linked slide should be directly after the slide that references it, so that a user navigating with only the keyboard can access the information in a logical way.

Hyperlinks that are presented onscreen should either be read by the narrator or provided as a link description (similar to an image description).

**Narration and Audio**

The narration or audio of the training should avoid phrases that are not meaningful on their own or apply only to a select group of users, such as the following words/phrases:

- “As you can see”
- “Click on...” (Instead say “Select” and include a description of what is to be selected).

Keep in mind that if a user cannot select something due to a mobility or visual impairment, an alternate method of accessing that information should be provided. One method is to provide that information in the slide directly following.

- Avoid ambiguous phrases that refer only to graphically defined images on the screen.
Bulleted or numbered lists in the audio (and in the audio only) should contain a semi-colon after each list item, a semi-colon and the word "and" for the penultimate list item and a period for the last list item.

Knowledge Checks/Knowledge Check Debriefs

In order to be Section 508 compliant, Knowledge Checks must adhere to the following requirements:

1. There must be two screens for each Knowledge Check: A Knowledge Check screen (that contains the content for the Knowledge Check) and a Knowledge Check Debrief screen (that contains the answer to the Knowledge Check).
2. The Knowledge Check cannot be required
3. The Knowledge Check audio must state the entire question and all of the answer choices.
4. The Knowledge Check Debrief should state the correct answer in sentence format.
5. The Knowledge Check Debrief screen should display all of the answer choices, with the incorrect answers grayed out.

Example of Knowledge Check:

Narration (notes section):
What are the three basic components of concrete?
   a) water;
   b) oil;
   c) cement;
   d) aggregate;
   e) concrete; or
   f) vinsol.

Select all that apply.
Example of Knowledge Check Debrief:

Narration (notes section):
The three basic components of concrete are water, cement, and aggregate. Recall that when mixed together, a chemical reaction occurs between the cement and water which eventually causes the mixture to harden and form concrete.

End-of-Course Assessment

In order to have students qualify for ECQ’s, the exams must have the following settings:
- Every question is required
- There is no feedback
- Each answer is communicated back to the LMS and tallied
- The final score must be given to the student, who must score better than 70% to pass

Give those constraints, this exam or test is not Section 508 compliant. Currently, TCCC is in the decision process related to solving this issue, most like learners who cannot complete the exam will call the NHI Training Assistance Center and an NHI representative will proctor the exam for the student verbally.

This version is not Section 508 compliant for several reasons.
- A learner using the keyboard to navigate cannot select the different multiple choice options and the Submit button (the mouse must be used)
- A learner using a screen reader will not know what option has been selected
- Learners using either a screen reader or the keyboard to navigate (or both) will not be able to obtain a score

In the future, TCCC will to provide an exam in WBT format that is fully 508 compliant. NHI has communicated this problem to Adobe via the Adobe Support Forum and will continue to monitor updates to Adobe Presenter for features that support Section 508 compliant QuizMaker settings.
LMS Integration

LMS integration is handled internally for all TCCC courses. The development team has no tasks associated with integration other than to assist in integration testing, if requested by TCCC.
Adobe Presenter

Templates

The purpose of the template is to provide learners with a consistent look and feel with all online TCCC courses they may take. The templates have established standard settings such as (Title, Body, Summary/Wrap-up) pages.

Standardized Screen Types

In addition to standard PowerPoint templates, TCCC standards include several standard screen types. Though the layout of each screen is not prescribed, the designer/developer will use the standards screens throughout a TCCC course.

The available screen types are documented in the table below.

<table>
<thead>
<tr>
<th>Screen Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module Introduction</td>
<td>The module introduction page orients the learner to the module. Most importantly, it captures the learner’s attention and creates a tension for learning. This page should provide the What’s In It for Me? (WIIFM). The estimated contact time (module duration) is provided along with the Module learning outcomes.</td>
</tr>
<tr>
<td>Lesson Introduction</td>
<td>The lesson introduction page orients the learner to the lesson. Lesson learning outcomes are stated.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong>: Lessons are optional. If the course does not contain lessons, do not use the lesson introduction template.</td>
</tr>
<tr>
<td>Content</td>
<td>The content screens provide the body of the instruction. Each screen should address an instructional concept, provide a transitional link between related concepts, provide a practical example or case study, or serve a similar instructional function.</td>
</tr>
</tbody>
</table>
| Embedded Questions  | The Adobe Presenter Quiz Manager provides six different types of question interaction:  
|                     | • Short answer  
|                     | • Matching  
|                     | • Multiple Choice  
|                     | • Fill-in-the-blank (not recommended)  
|                     | • Rating Scale (not recommended)  
|                     | • True/False  
<p>|                     | The questions can be modified to work as unscored quizzes (i.e., knowledge checks).                                                                                                                                                                                                  |
| Lesson Summary      | The lesson summary page wraps up the lesson. Lesson learning outcomes are paraphrased. This page also provides instruction on how to continue (e.g., select another lesson). If desired, one (the same) graphic may be used on every lesson summary page in a course. Refer to section 3.3.4 on course completion requirements.                                          |
|                     | <strong>NOTE</strong>: Lessons are optional. If the course does not contain lessons, do not use the lesson summary template.                                                                                                                                                                   |
| Module Summary      | The module summary page wraps up the module. Module learning outcomes are paraphrased. If the module contains lessons, the connectivity between the module’s lessons is emphasized. This page also provides instruction on how to continue (e.g., select another module). If desired, one (the same) graphic may be used on every module summary page. |</p>
<table>
<thead>
<tr>
<th>Screen Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| End-of-Course Assessment Introduction | The course assessment introduction page orients the learner to the course assessment. Clear instructions on how to take the test are provided. The number of questions in the test is stated. The test scoring page is explained. The learner is informed that the threshold for mastery is 70% for the course test. This page also provides instruction on how to start the test.  

**NOTE:** End of Course Assessments are optional. If the course does not contain an End of Course Assessment, do not use this template. |

| End-of-Course Assessment Questions   | Similar to the embedded question templates, they include the six different types of question interaction:  

- Short answer  
- Matching  
- Multiple Choice  
- Fill-in-the-blank (not recommended)  
- Rating Scale (not recommended)  
- True/False  

**NOTE:** End of Course Assessments are optional. If the course does not contain and End of Course Assessment, do not use this template. |

| End-of-Course Assessment Report      | The course assessment report page is the course “scorecard” for the learner. The learner’s score on the course is provided as a percentage. The learner is informed, in text, if he or she passed the assessment.  

The learner is also directed to the Level 1 course evaluation.  

**NOTE:** End of Course Assessments are optional. If the course does not contain and End of Course Assessment, do not use this template. Include the Level 1 course evaluation link on the Module Summary page. |

---

**Standard Text for Use in TCCC WBT**

**NOTE:** Red text denotes text that must be modified in the WBT Screen.
**Lesson Introduction**  
**NOTE:** Lessons are optional. If the course does not contain lessons, do not use the lesson introduction template.

Welcome to the Lesson Title lesson.  
*Provide the attention gaining devise and the relevance of the material to the intended audience.*  
After completing this lesson, you will be able to:  

- Enabling Learning outcome  
- Enabling Learning outcome  
- Enabling Learning outcome  

This lesson will take approximately XX minutes to complete.

<table>
<thead>
<tr>
<th>Content</th>
<th>No standardized text.</th>
</tr>
</thead>
</table>
| **Embedded Practice or Module Knowledge Check - Short Answer** | Enter Question Text  
Enter your answer, and then select Submit. |
| **Embedded Practice or Module Knowledge Check - Matching** | Enter Question Text  
Enter the letter of the item on the right beside the corresponding item on the left, and then select Submit. Y |
| **Embedded Practice or Module Knowledge Check - Multiple Choice** | Enter Question Text  
Select all that apply, and then select Submit. |
| **Embedded Practice or Module Knowledge Check - Fill-in-the-blank** | Enter Question Text  
Enter your answer, and then select Submit. |
| **Embedded Practice or Module Knowledge Check True/False** | Enter Question Text  
Select your answer, and then select Submit. |

**Lesson Summary**  
This lesson provided information on the following key points:  

- Enter key point

**NOTE:** Lessons are optional. If the course does not contain lessons, do not use the lesson summary template. Include as many key points as are relevant for the lesson.

**Module Summary**  
Note: Include at least one key point for every lesson, if lesson are used. Otherwise, include as many key points as are relevant for the module.

This module provided information on the following key points:  

- Enter key point  
- Enter key point  
- Enter key point

You have completed this lesson. Return to the Main Menu to select another option.

You have completed this module. Return to the Main Menu to select another option.
Course Exam Introduction

The course exam contains XX questions. Since you can only take this exam once, be sure you have enough time to complete it. All questions allow for only one answer attempt. Some questions may ask you to “Select ALL the correct answers, then select Submit.” Be sure to select ALL the correct choices. Partial answers will be scored as incorrect. You must score at least 70% or better on this exam to be eligible for the XX Continuing Education Credits (CEUs) provided to participants who satisfactorily complete this course.

<table>
<thead>
<tr>
<th>Course Exam Questions - Short Answer</th>
<th>Enter Question Text</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enter your answer, and then select Submit.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Course Exam Questions - Matching</th>
<th>Enter Question Text</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enter the lower case letter of the item on the right beside the corresponding item on the left, or select and drag the item on the left with the corresponding letter and then select Submit.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Course Exam Questions - Multiple Choice</th>
<th>Enter Question Text</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select all that apply, and then select Submit.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Course Exam Questions - Fill-in-the-blank</th>
<th>Enter Question Text</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enter your answer, and then select Submit.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Course Exam Questions - True/False</th>
<th>Enter Question Text</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select your answer, and then select Submit.</td>
</tr>
</tbody>
</table>

Adobe Presenter Settings

Most settings are established in the template. Use the following Step/Action tables to re-establish or double check settings to ensure a consistent user experience.

Theme Editor Settings

Theme settings may be edited as part of the publication process. The developer may opt to edit theme settings after selecting Publish in the Adobe Presenter menu.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open the Theme Editor window by selecting Adobe Presenter ➔ Presentation Settings ➔ Theme Editor.</td>
</tr>
</tbody>
</table>
| 2    | Select NHI Template 1 from the Theme Name dropdown menu.  
   **NOTE:** If you do not have the NHI Template 1 option, select Save As from beside the Theme Name dropdown. In the Save as ... window, enter NHI Template 1, then select OK. |
| 3    | Set the following in the Customize Options:  
   • Select Enable Mode Switching  
   • Select Default from the Display option.  
   • Select Right from the Location of Layout dropdown menu  
   • Select the Outline Pane Checkbox  
   • Deselect the Thumbnail Pane Checkbox  
   • Select the Notes Pane Checkbox  
   • Select the Search Pane Checkbox  
   • Deselect the Enable Quiz Pane Checkbox |
<table>
<thead>
<tr>
<th>4</th>
<th>Select Notes from the Default Pane on Startup dropdown menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Deselect all options in the Presenter Info Options.</td>
</tr>
<tr>
<td>6</td>
<td>Select Modify Text Labels → Notes Tab Text and change the Custom Text to Narration. Select OK.</td>
</tr>
</tbody>
</table>
| 7 | Select Theme → More Colors from the Appearance box. In the Color window, enter the following:  
   - Hue: 140  
   - Sat: 240  
   - Lum: 48  
   - Red: 0  
   - Green: 51  
   - Blue: 102  
   Select OK. |
| 8 | Select Glow Color → More Colors from the Appearance box. In the Color window, enter the following:  
   - Hue: 108  
   - Sat: 25  
   - Lum: 195  
   - Red: 202  
   - Green: 212  
   - Blue: 209  
   Select OK. |
| 9 | Select Font Color from the Appearance box, and then select White in the Color window. Select OK. |
| 10 | Select Background Color → More Colors from the Appearance box. In the Color window, enter the following:  
    - Hue: 75  
    - Sat: 8  
    - Lum: 110  
    - Red: 114  
    - Green: 121  
    - Blue: 113  
    Select OK. |
| 11 | Select OK on the Theme Colors window. |
| 12 | Select OK on the Theme Editor window to save all your settings. |

**Knowledge Check Settings**

Module knowledge checks and the end-of-course assessment are both created using the Quiz Manager. Knowledge checks should be created as ONE question per quiz, or ONE Knowledge Check per quiz. The end-of-course assessment should be created as one quiz with multiple questions.

**Module Quiz Manager Settings**
Use the following step/action chart to set up a Knowledge Check. Note that you must set up a quiz before you can enter the questions.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open the Quiz Manager window by selecting Adobe Presenter → Quiz Manager.</td>
</tr>
</tbody>
</table>
| 2    | In the Quiz Manager window, select the Output Options tab:  
|      | - Deselect Display question list in quiz pane  
|      | - Deselect Show incomplete quiz warning |
| 3    | In the Quiz Manager window, select the Reporting tab, and deselect Enable reporting for this presentation. |
| 4    | In the Quiz Manager window, select the Default Labels tab, and set:  
|      | - In the Default question button labels section:  
|      |   - Submit button text: Submit  
|      |   - Clear button text: Clear  
|      | - In the Default question feedback section:  
|      |   - Select Correct message, and enter Correct. Advance to the next slide for a debrief. Select anywhere to continue.  
|      |   - Select Incorrect message, and enter Incorrect. Advance to the next slide for a debrief. Select anywhere to continue.  
|      |   - Select Retry message, and enter Incorrect. {Add hint feedback on slide} Select anywhere to try again.  
|      |   - Select Incomplete message, and enter You have provided an incomplete answer. Select anywhere to try again.  
|      | NOTE: Custom feedback should be provided to all participants on the debrief slides. |
| 5    | In the Quiz Manager window, select the Quizzes tab. |
| 6    | Select Edit in the Quiz box to open the Quiz window. |
| 7    | Select the Quiz Settings tab. |
| 8    | In the Name field, enter Quiz |
| 9    | From the Required dropdown, select Optional – the user can skip this quiz |
| 10   | In the Settings section:  
|      | - Select Allow backward movement  
|      | - Select Allow user to review quiz  
|      | - Deselect Include instructions slide  
|      | - Deselect Show score at end of quiz  
|      | - Select Show questions in outline  
|      | - Deselect Shuffle questions  
|      | - Deselect Shuffle answers  
| 11   | Select Question Review Messages..., and set:  
|      | - Correct: You answered this question correctly.  
|      | - Incomplete: You did not answer this question completely.  
|      | - Incorrect: Incorrect. The correct answer is:  
|      | Select OK to close the Question Review Messages... window. |
| 12   | Select Pass/Fail Options tab and:  
|      | - In the Pass/Fail options section, set 0% or more of total score to pass  
|      | - In the If passing grade section, select Go to next slide from the Action dropdown  
|      | - In the If failing grade section:  
|      |   - Select Infinite Attempts  
|      |   - Select Go to next slide from the Action dropdown. |
| 13   | Select OK to close the New Quiz window |
**Module Question Settings**

After you have set up the quiz, you can create the question(s) for the quiz. Remember that for the embedded Knowledge Checks, there is one question per quiz; for the end-of-course assessment, there is one quiz for the assessment, with multiple questions in the quiz.

Use the step/action chart to set up the quiz questions.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the Quiz Manager window, select the quiz to which you are adding a question, then select the drop down arrow next to Add Question.</td>
</tr>
<tr>
<td>2</td>
<td>Select the type of question indicated in the storyboards, then select Create Graded Question.  &lt;br&gt;<strong>NOTE:</strong> The type of question used in this example is Multiple Choice. The inputs are similar for other types of questions, unless noted.</td>
</tr>
<tr>
<td>3</td>
<td>In the Question window, the Question section is similar for all questions types. Set the following:  &lt;br&gt;• Name field: Learning Outcome {x}  &lt;br&gt;<strong>NOTE:</strong> Indicate which Learning Outcome/Objective the question addresses.  &lt;br&gt;• Question field: Enter Knowledge Check  &lt;br&gt;• Score field: 0  &lt;br&gt;4</td>
</tr>
<tr>
<td>5</td>
<td>From the Numbering dropdown, select the lower case characters (a, b, c, . . .)</td>
</tr>
<tr>
<td>6</td>
<td>In the Answers section, select Add, then enter or copy/paste the text for the answer options. Select the correct answer(s).</td>
</tr>
<tr>
<td>7</td>
<td>Select the Options tab, and set the following:  &lt;br&gt;• In the Type section:  &lt;br&gt;  o Select Graded - there are right and wrong answers from the  &lt;br&gt;  o Select Show clear button  &lt;br&gt;• In the If correct answer section:  &lt;br&gt;  o Select Go to next slide from the Action dropdown  &lt;br&gt;  o Select Show correct message  &lt;br&gt;• In the If wrong answer section:  &lt;br&gt;  o Enter 2 in the Allow user field  &lt;br&gt;  <strong>NOTE:</strong> Set to 1 for True/False or Yes/No questions.  &lt;br&gt;  o Select Go to next slide from the Action dropdown  &lt;br&gt;  o Select Show error message  &lt;br&gt;  o Select Show retry message  &lt;br&gt;  o Select Show incomplete message</td>
</tr>
<tr>
<td>8</td>
<td>Select the Reporting tab and deselect Report answers</td>
</tr>
<tr>
<td>9</td>
<td>In the Question window, select OK.</td>
</tr>
<tr>
<td>10</td>
<td>In the Quiz Manager window, select OK.</td>
</tr>
<tr>
<td>11</td>
<td>Repeat for each knowledge check.</td>
</tr>
</tbody>
</table>

**How to Create a Knowledge Check Debrief**

Knowledge Check Debrief Slides allow Adobe Presenter Knowledge Checks to meet Section 508 compliance. Debrief Slides are required after each Knowledge Check in order for Section 508 compliance to be met.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | Create a new, blank slide directly after the Knowledge Check.  
• Select the Knowledge Check slide  
• Select Insert  
• Select New Slide  
A new, blank slide will be inserted following the quiz question slide.  
**NOTE:** Do not copy and paste the original Knowledge Check slide. You must create a new slide. |
| 2    | Insert quiz content into the debrief slide  
• On the Knowledge Check slide, hold down the *control key* (CTRL) and select the text box that contains the questions and all answer choices.  
• Copy the objects by right-clicking and selecting copy  
• On the Knowledge Check debrief slide, paste the question and all answer choices. (These two slides should now look identical). Notice that the radio buttons/check boxes or other quiz related elements are on the debrief slide. These must be deleted.  
  o To delete the quiz related elements, select the entire answer.  
  o Right-click on the answer and choose *Grouping* and then *Ungroup*.  
  o You can now delete the radio button, check box, or other quiz element.  
  o Repeat this process for all answer choices until interactive quiz elements are gone. |
| 3    | Format debrief slide quiz content.  
• Set all incorrect answers to *Gray*, *RGB color 150, 150, 150* on the CUSTOM tab in the colors dialog box  
• Leave the correct answer or answers as *Black*, *RGB color 0, 0, 0* |
| 4    | Insert correct narration  
• At a minimum, the debrief slide narration should provide the correct answer  
• Sample narration:  
  o The correct answer is d) All of the above. |

**Learner Assessment Settings**

The end-of-course assessment is also created using the Quiz Manager. The end-of-course assessment should be created as one quiz with multiple questions in a separate PowerPoint file.

**End-of-Course Assessment Quiz Settings**

Use the following step/action chart to set up an end-of-course assessment. You must set up a quiz before you can enter the questions.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open the <strong>Quiz Manager</strong> window by selecting <em>Adobe Presenter ➔ Quiz Manager</em>.</td>
</tr>
</tbody>
</table>
| 2    | In the **Quiz Manager** window, select the **Output Options** tab:  
  • Deselect *Display question list in quiz pane*  
  • Deselect *Show incomplete quiz warning* |
| 3    | In the **Quiz Manager** window, select the **Reporting** tab, then select *Enable reporting for this presentation*. Set the following:  
  • **Learning Management System:** Adobe Presenter  
  • **Report Pass or Fail:** Report status as defined by report data  
  • **Choose report data:** Report to Adobe Presenter  
  • **Report score to LMS as:** Score  
  • **Reporting level:** Only report the score  
Select OK |
### End-of-Course Assessment Question Settings

After you have set up the quiz, you can create the questions. For the end-of-course assessment, there is one quiz for the assessment, with multiple questions in the quiz.

Use the step/action chart to set up the quiz questions.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 4    | In the Quiz Manager window, select the Default Labels tab, and set:  
  - In the Default question button labels section:  
    o Submit button text: Submit  
    o Clear button text: Clear  
  - In the Default question feedback section:  
    o Deselect Correct message.  
    o Deselect Incorrect message.  
    o Deselect Retry message.  
    o Select Incomplete message, and enter: You must answer the question before continuing. |
| 5    | In the Quiz Manager window, select the Quizzes tab. |
| 6    | Select Add New Quiz to open the New Quiz window. |
| 7    | Select the Quiz Settings tab. |
| 8    | In the Name field, enter [Course Name]. |
| 9    | From the Required dropdown, select Answer all - the user must answer every question to continue |
| 10   | In the Settings section:  
  - Deselect Allow backward movement.  
  - Deselect Allow user to review quiz.  
  - Deselect Include instructions slide.  
  - Select Show score at end of quiz.  
  - Deselect Show questions in outline.  
  - Deselect Shuffle questions.  
  - Deselect Shuffle answers. |
| 11   | Select Pass/Fail Options tab and:  
  - In the Pass/Fail options section, set 70% or more of total score to pass.  
  - In the If passing grade section, select Go to next slide from the Action dropdown.  
  - In the If failing grade section:  
    o Set Allow user to 1 attempts.  
    o Select Go to next slide from the Action dropdown. |
| 12   | Select OK to close the New Quiz window |

### Use the step/action chart to set up the quiz questions.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the Quiz Manager window, select the quiz to which you are adding a question, then select the drop down arrow next to Add Question.</td>
</tr>
</tbody>
</table>
| 2    | Select the type of question indicated in the storyboards, then select Create Graded Question.  
  
  **NOTE:** The type of question used in this example is Multiple Choice. The inputs are similar for other types of questions, unless noted. |
| 3    | In the {Type} Question window, the Question section is similar for all questions types. Set the following:  
  - Name field: Learning Outcome {x}  
    
    **NOTE:** Indicate which Learning Outcome/Objective the question addresses.  
  - Question field: Enter Knowledge Check |
### TCCC WBT Training Standards Guide

**Step** | **Action**
---|---
| 39 | Score field: Enter the number of points for the question.  
**NOTE:** The total number of points for an end-of-course assessment should be 100. Distribute points as evenly as possible through all questions on the assessment, but only include 1 question per learning outcome.

| 4 | From the **Type** dropdown, select either single response or multiple responses, based on the storyboard. |

| 5 | From the **Numbering** dropdown, select the lower case characters (a, b, c, . . .) |

| 6 | In the **Answers** section, select **Add**, then enter or copy/paste the text for the answer options. Select the correct answer(s). |

| 7 | Select the **Options** tab, and set the following:  
- In the **Type** section:  
  - Select **Graded - there are right and wrong answers** from the  
  - Deselect **Show clear button**  
- In the If correct answer section:  
  - Select **Go to next slide** from the **Action** dropdown  
  - Deselect **Show correct message**  
- In the If wrong answer section:  
  - Enter 1 in the **Allow user** field  
  **NOTE:** Set to 1 for all question types in the end-of-course assessment.  
  - Select **Go to next slide** from the **Action** dropdown  
  - Deselect **Show error message**  
  - Select **Show incomplete message** |

| 8 | Select the **Reporting** tab and select **Report answers**, then:  
- Select the {Course Name} from the **Name** dropdown.  
- Do not change the Interaction ID. |

| 9 | In the **Question** window, select **OK**. |

| 10 | In the **Quiz Manager** window, select **OK**. |

**Question Formatting on PowerPoint slides**

After a Quiz is created in the Adobe Presenter Quiz Manager, the text will not use the same size font or color as the master slide so the font and color must be altered manually.*

### Step | **Action**
---|---
| 1 | Add the Question to the slide in a separate text box  
- Set font to **Verdana 22 pt Bold**  
- Align to top-left of grid  
- Set color to **BLACK**  
- Set **RGB color 0, 0, 0** |

| 2 | Set answer font to **Verdana 20 pt**  
- Set **RGB color 0, 0, 0** |

| 3 | Format answers if needed.  
- Select all answers by holding the **SHIFT** key and clicking each text box.  
- Select **Format > Object**  
- On the **TEXT BOX** tab, un-check “word wrap text in auto-shape””. This will cause the text to continue off the page  
- Select the spot after the last word that fits within the grid and select the **ENTER** key while holding **SHIFT**. Complete for every line of text |

| 4 | Format response boxes  
- Manually adjust the font and color of the response boxes  
- Set font to **Verdana 20 pt** and **RGB color 0, 0, 0**  
- Set **box fill color** to **RGB 202, 212, 209** or the same color as the sub-navigation bar  
- Arrange the boxes so no answers are covered |

| 5 | Format **Submit and Clear buttons** |
Presentation Settings

Before publishing the PowerPoint file, modify the Presentation Settings as follows.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Navigate to the Adobe Presenter menu and select <strong>Presentation Settings</strong>.</td>
</tr>
<tr>
<td>2</td>
<td>Select the <strong>Appearance</strong> tab. In the <strong>Title</strong> field, enter the module (i.e. Module 1, Module 2, Introduction, End of Course Test, etc.)</td>
</tr>
<tr>
<td>3</td>
<td>In the <strong>Theme</strong> field, select NHI Theme 1.</td>
</tr>
<tr>
<td>4</td>
<td>Select the <strong>Playback</strong> tab. Select <strong>Auto play on start</strong> and select <strong>Include slide numbers in outline</strong>.</td>
</tr>
</tbody>
</table>
| 5    | Select the **Quality** tab.  
|      | - In the **Publish For** field, select Adobe Connect Pro  
|      | - Select **Publish Audio** and choose **CD Quality**  
|      | - For **Image Quality**, select **High**  
|      | - Deselect **Control Publishing**  
|      | - Select **Use these settings for new presentations** |
| 6    | Select the **Attachments** tab. Here you will attach a PDF version of the presentation. If you have not done so already, print/convert the presentation to Adobe PDF in notes view.  
|      | **NOTE:** Ensure all text in the notes will fit on the slide in notes view.  
|      | - Select the **Add** button.  
|      | - In the **Name** field, enter “Module {x} PDF”  
|      | - In the **Type** field, choose **File**  
|      | - In the **Location** field, chose the file folder icon. Navigate to the PDF and select it. Choose the **Open** button to select the PDF. Select Ok to save the attachment. |
| 7    | Select **OK** to save your settings and exit the Presentation Settings. |

Slide Manager

Before publishing the PowerPoint file, modify the Slide Manager settings as follows.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Navigate to the Adobe Presenter menu and select <strong>Slide Manager</strong>.</td>
</tr>
<tr>
<td>2</td>
<td>Choose the <strong>Select All</strong> button.</td>
</tr>
<tr>
<td>3</td>
<td>In Slide 1, choose the hyperlinked word No next to the <strong>Advance by User</strong> setting. A drop down will open.</td>
</tr>
<tr>
<td>4</td>
<td>Select <strong>Yes</strong> to make all slides user advance.</td>
</tr>
<tr>
<td>5</td>
<td>Select <strong>OK</strong> to make all slides user advance.</td>
</tr>
</tbody>
</table>

Hyperlinks

Hyperlinks can be used externally in Adobe Presenter to link to external Web sites, or can be used internally to link to slides within the PowerPoint Presentation.

External Hyperlinks
## External Hyperlinks

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Choose the onscreen element you would like to provide as the hyperlink (i.e. the element that the participant will select in order to access the hyperlink). This element could be text, shapes, graphics, etc.</td>
</tr>
<tr>
<td>2</td>
<td>Select the onscreen element that you have chosen for the hyperlink.</td>
</tr>
<tr>
<td>3</td>
<td>Right-click on the highlighted element. Choose <strong>Hyperlink</strong>.</td>
</tr>
<tr>
<td>4</td>
<td>Select <strong>Existing File or Web Page</strong>.</td>
</tr>
<tr>
<td>5</td>
<td>In the <strong>Address</strong> field, type in the web address of the external site to which you are linking.</td>
</tr>
</tbody>
</table>

**NOTE:** If you are linking text, make sure to select all of the text that will be hyperlinked.

Internal Hyperlinks

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Choose the onscreen element you would like to provide as the hyperlink (i.e. the element that the participant will select in order to access the hyperlink). This element could be text, shapes, graphics, etc.</td>
</tr>
<tr>
<td>2</td>
<td>Select the onscreen element that you have chosen for the hyperlink.</td>
</tr>
<tr>
<td>3</td>
<td>Right-click on the highlighted element. Choose <strong>Hyperlink</strong>.</td>
</tr>
<tr>
<td>4</td>
<td>Select <strong>Place in This Document</strong>.</td>
</tr>
<tr>
<td>5</td>
<td>In the <strong>Select a place in this document</strong>, choose the slide that you would like to link to.</td>
</tr>
</tbody>
</table>

Internal hyperlinks are used to create interactions. Although interactions in TCCC documents appear to be occurring on the same slide, they are in fact slides linked to each other.

## Embedding Flash Objects (Published Captivate Animation)

Flash objects can be embedded into PowerPoint and, when published in Adobe Presenter, act as integrated animations that seamlessly work within the presentation. In order to embed an animated flash movie into Adobe Presenter, use the following steps.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ensure that you flash object has been published and is in the .swf format.</td>
</tr>
<tr>
<td>2</td>
<td>Select the <strong>Adobe Presenter</strong> menu and choose <strong>Insert Flash</strong>.</td>
</tr>
<tr>
<td>3</td>
<td>Select the .swf file you would like to embed and choose <strong>Open</strong>.</td>
</tr>
<tr>
<td>4</td>
<td>You will see an outline of the .swf file on the screen. You may need to resize or reposition the object. This is done manually.</td>
</tr>
<tr>
<td>5</td>
<td>In order for the Flash to be Section 508 compliant, you must allow the animation to be controlled with the presentation playbar, or it must have it’s own play/pause/rewind/stop features. To control the animation with the presentation playbar:</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Adobe Presenter</strong> menu and then <strong>Manage Flash</strong></td>
</tr>
<tr>
<td></td>
<td>• Check the box next to <strong>Control with presentation playbar</strong></td>
</tr>
<tr>
<td></td>
<td>• Select OK to save the setting</td>
</tr>
</tbody>
</table>

**Tips for embedding published Captivate files in Adobe Presenter**

- If you are recording an animated screen capture, consider the resolution of the movie you are taking. If the objects on your screen are too small, they will be even smaller when embedded in the PowerPoint screen. Capture at as small a resolution as possible while still fitting everything on the screen.
- Use a preloader so that participants know that the screen is loading and how close the animation is to starting.
- Do not fade the captivate presentation out at the end. Instead, use a text box to communicate to participants that the animation has completed and that they should advance to the next slide.
- Try to keep animations to no longer than 2 minutes
- Synch animation with the narration on that slide
Appendix

WBT Sample Template

Master Slide:

Title Bar, Course Title: Verdana 16-point bold - RGB color: 255, 255, 255
Title Bar, Course Number: Verdana 14-point bold - RGB color: 255, 255, 255

Side Bar, Lesson Links: Verdana 14-point bold - RGB color: 255, 255, 255
Side Bar, Resources, Glossary, and Help links: Verdana 14-point bold - RGB color: 255, 255, 255

Slide Text: Suggested
Instruction text - Bullet Level 1 - Verdana 22-point - RGB color: 0, 0, 0
Instruction text - Bullet Level 2 - Verdana 20-point - RGB color 0, 0, 0
Instruction text - Bullet Level 3 - Verdana 18-point - RGB color 0, 0, 0

Slide text should be no smaller than Verdana 16-point font.
Level 1 Evaluation

Summative evaluations occur after deployment of the courseware and/or training materials, and validates that the materials meet the need identified effectively and efficiently. TCCC uses Kirkpatrick’s Levels of Evaluation Model as its standard approach. All training undergoes a Level 1 evaluation. Level 2, Level 3 and Level 4 evaluations are at the discretion of TCCC.

Level 1 evaluations measure the learner’s reaction to the training. TCCC uses a standardized, web-based evaluation form. The training links directly to the evaluation form from the final page in the last module.

The level 1 evaluations used by TCCC are created by training evaluation system. Seminars do not use level 1 evaluations.

Create an Evaluation Link

Evaluation links are generated from the course number and the session number that are assigned by the NHI business application, which TCCC uses as part of a partnership with NHI.

The evaluation link will appear in this format:

https://www.nhies.info/online-eval.html?coursenumber=[CMTS course number]&sessionnumber=[CMTS session number]

Here is an example:

https://www.nhies.info/online-eval.html?coursenumber=134095&sessionnumber=20090601

Add Link to Course

Add the evaluation link to the final slide of the WBT by hyperlinking text or adding a hyperlinked action box. See the samples below:

Box: Text: Go to this link to take the course evaluation.

Print Course Certificate
Add Ancillary Files

The following are the directions to upload ancillary files to the FHWA Adobe Server. The TCCC Certificate is an example of an ancillary file. Other ancillary files would include glossary, help, and training resources files.

Upload the PDF ancillary file to the course folder on the Adobe server by first selecting “New Content.”

Click on Browse to locate the ancillary files.

Use the naming convention to name the file under “Enter Content Information.” Click “Save” when finished. Note the URL for future use.
To set permissions, click on Set Permissions on the same menu bar as “Content Information.” Set the permissions as public. Click “Save.”
Acronym List

The following acronyms have been used in this document.

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDIE</td>
<td>Analysis, Design, Development, Implementation, Evaluation</td>
</tr>
<tr>
<td>DDP</td>
<td>Detail-level Design Plan</td>
</tr>
<tr>
<td>FHWA</td>
<td>Federal Highway Administration</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>HDP</td>
<td>High-level Design Plan</td>
</tr>
<tr>
<td>ISD</td>
<td>Instructional Systems Design; Instructional Systems Designer</td>
</tr>
<tr>
<td>NHI</td>
<td>National Highway Institute</td>
</tr>
<tr>
<td>QA</td>
<td>Quality Assurance</td>
</tr>
<tr>
<td>QC</td>
<td>Quality Control</td>
</tr>
<tr>
<td>SCO</td>
<td>Sharable Content Object</td>
</tr>
<tr>
<td>SCORM</td>
<td>Sharable Content Object Reusability Model</td>
</tr>
<tr>
<td>TCCC</td>
<td>Transportation Curriculum Coordination Council</td>
</tr>
<tr>
<td>W3C</td>
<td>World Wide Web Consortium</td>
</tr>
<tr>
<td>WBT</td>
<td>Web-based Training</td>
</tr>
</tbody>
</table>